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RESUMEN

La cuantificacién de la geomorfometria de una cuenca es un elemento esencial en
la hidrologia de la cuenca, ya que cada uno de elementos interviene en el
comportamiento de la cuenca, por ello es de suma importancia la cuantificacion
siguiendo los procedimientos matematicos, graficos y estadisticas en cada caso.

El presente trabajo consistio en la delimitacion de todas las subcuencas de la cuenca
de Marafidn, teniendo como objetivo principal la determinar las relaciones entre los
parametros geomorfometricos de las subcuencas de la cuenca Marafion mediante
GIS. Por ello se realizo la determinacion de todos los parametros geomorfométricos
empleando el software ArcGIS y Excel, y como punto final se busco las
correlaciones entre todos los parametros determinados empleando tecnicas
estadisticas como es la correlacion de Pearson y el analisis de componente principal
para luego proponer modelos de prediccion mediante la regresion lineal,
logaritmica, exponencial, polindmica y potencial, para cada caso se empled los
software estadistico SPSS, que permite realizar un andlisis adecuado de todos los

parametros.

Palabras claves: correlacion, variables geomorfométricos, cuencas.
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ABSTRACT

The quantification of the geomorphometry of a basin is an essential element in the
hydrology of the basin, since each element intervenes in the behavior of the basin,
therefore it is of great importance the quantification following the mathematical
procedures, graphs and statistics in each case.

The present work consisted in the delimitation of all the sub basins of the Marafién
basin, having as main objective the determination of the relationships among the
geomorphometric parameters of the sub basins of the Marafion basin through GIS.
Therefore, the determination of all the geomorphometric parameters using the
ArcGIS and Excel software was carried out, and as a final point, the correlations
between all the parameters determined were searched using statistical techniques
such as the Pearson correlation and the main component analysis to then propose
models of prediction through linear, logarithmic, exponential, polynomial and
potential regression, for each case we used the statistical software SPSS, which

allows an adequate analysis of all parameters.

Key words: correlation, geomorphometric variables, basins.
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I. INTRODUCCION
Los parametros geomorfométricos son elementos que identifican a las cuencas
hidrogréficas, la cuantificacion de dichos parametros es de suma importancia ya
que indican el comportamiento de la cuenca cuando se tiene las maximas
avenidas, la existencia de la relacion de estos parametros permitira la
identificacién y el calculo de los parametros de manera mas rapido.
El presente trabajo consiste en la delimitacion de todas las subcuencas de la
cuenca de Marafion, como punto de partida, luego se realizo la determinacion de
todos los parametros geomorfométricos para ello se empled el software ArcGIS
y Excel, y como punto final se busco las relaciones entre todos los parametros
determinados empleando la técnica estadistica de correlacion de Pearson y el
analisis de componente principal para luego proponer modelos de prediccion
mediante la regresion lineal, logaritmica, exponencial, polindmica y potencial,
para cada caso se empleo los software estadistico SPSS, que permite realizar un
analisis adecuado de todos los parametros.
1.1. Objetivos
1.1.1. Objetivo general
Determinar las relaciones entre los parametros geomorfométricos

de las subcuencas de la cuenca Marafion mediante GIS.

1.1.2. Objetivos especificos
1) Delimitar las subcuencas empleando el sistema de informacion
geografica.
2) Calcular los parametros geomorfométricos de las subcuencas de

la cuenca de Marafién mediante GIS.



1.2.

1.3.

3) Hallar las relaciones entre los pardmetros geomorfométricos de
las subcuencas de la cuenca Marafion.
Hipotesis
Existen  relaciones  significativas entre  los  parametros
geomorfométricos de las subcuencas de la Cuenca Marafion.
Variables
Se consideran los pardmetros de forma, tales como coeficiente de
compacidad, factor de forma, coeficiente de forma, relacion de
elongacion, relacion de circularidad, parametros de relieve tales como
altitud media, pendiente de la cuenca, pendiente del cauce principal, y
parametros de drenaje densidad de drenaje, relacion de bifurcacion,

orden de las corrientes.



I1. MARCO TEORICO
2.1. Antecedentes

Cerignoni y Rodriguez (2005) en su investigacion analisis morfométrico
de la microcuenca “C” nlcleo Cunha, Sao Paulo Brasil, analizo la
morfometria de la microcuenca con ayuda del sistema de informacién
geogréafica (SIG), para estimar los parametros dimensionales, la densidad
de drenaje, asi como analizar las caracteristicas de la pendiente, a través
de la caracterizacion de las dimensiones de datos altimétricos y coeficiente
de rugosidad.

Moreno y Romero (2015) en su investigacion correlacion entre
caracteristicas de los parametros morfométricos y parametros del drenaje
superficial de las cuencas que desembocan en la Ciénaga Grande del
Magdalena, analizd la relacion que existe entre los parametros
morfométricos de una cuenca y sus respectivos caudales de escorrentia,
teniendo en cuenta factores como drenajes, tipos de suelo y pendientes.
Para esto fue necesario delimitar las cuencas y subcuencas de los rios Frio
el cual fue dividido en 22 subcuencas, rio Tucurinca con 23 subcuencas,
Avracataca con 29 subcuencas y Fundacion con 34 subcuencas.

Viramonte et al. (2007) en su investigacion morfometria de la cuenca del
rio San Pedro, Conchos, Chihuahua analizo los parametros morfométricos
de la cuenca, y establecen el comportamiento evolutivo de la misma. Se
empled el programa model driven engineering (MDE) a una escala de
1:50,000 para el célculo de la superficie, perimetro, forma, relieve y

densidad de drenaje de la cuenca. Para la forma de la cuenca, los indices



de compacidad y elongacion fueron: 2.41 y 0.56, respectivamente,
indicando que la cuenca varia de oval-oblonga a rectangular, lo que influye
en la actividad dinamica del drenaje y en el tiempo de concentracion de las
aguas de lluvia al cauce principal, aumentando la dinamica del flujo del
agua y el potencial de erosion y disminuyendo el tiempo de concentracion.
La curva y el andlisis hipsométrico generado a partir de las altitudes,
mostraron una estrecha correlacion indicando que la zona se encuentra en
una etapa intermedia entre la fase de equilibrio relativo o de madurez y la
de desequilibrio o juventud, implicando un potencial erosivo que no debe
subestimarse. La densidad de drenaje, muestra que la cuenca esta
pobremente drenada donde la textura y la vegetacion juegan un papel
importante en la retencion de lluvia e infiltracion con un tiempo de
concentracion de escurrimientos de 31 d. Las caracteristicas
morfométricas y la red de drenaje tan solo atenudan los efectos y la
vigorosidad de las crecidas importantes para estudios de eventos
inesperados de precipitacion en el afio.

Sreedevi, Owais, Khan, y Ahmed (2009) en su trabajo de investigacion
analisis morfométrico de una cuenca hidrogréfica del sur de la India a
partir de datos SRTM y SIG para estudiar la morfometria de drenaje y su
influencia en la hidrologia de la cuenca Wailapalli, se realiz6 un estudio
detallado utilizando datos del shuttle radar topographic mision (SRTM)
(mision topogréafica del radar shuttle) para la preparacién del modelo de
elevacion digital (DEM), utilizando el sistema de informacidn geogréafica

(SIG) en la evaluacion de los limites, areas y parametros morfométricos.



El estudio revela que la forma alargada de la cuenca es principalmente
debido al efecto guiado de empuje y fallas. Las corrientes de orden inferior
estan dominando la cuenca. El desarrollo de la corriente en la zona de la
cuenca estd mas o menos afectado por la lluvia. La relacién de bifurcacion
(Rb) medio de toda la cuenca es de 3,89 lo que indica que el patron de
drenaje no estd muy influido por las estructuras geoldgicas. La relacién de
alivio indica que la capacidad de descarga de estas cuencas es muy alta 'y
el potencial de las aguas subterraneas es escaso. Estos estudios son muy
atiles para la planificacion de la recoleccion de agua de lluvia y de la
gestion de las cuencas hidrogréaficas.

INRENA (2007) en el trabajo de evaluacion de los recursos hidricos en las
cuencas de los rios Cabanillas y Lampa — Juliaca, hizo el trabajo por
intermedio de la Intendencia de los Recursos Hidricos, Administracion de
técnica del distrito de riego Juliaca; se realizo este trabajo con fines de
aprovechamiento hidrico en las cuencas alto andinas de la region Puno.
Tarazona (2005) en la tesis generacion de descargas mensuales en
subcuencas de la cuenca del rio santa utilizando el método de lutz scholz,
indica que mediante procedimientos elaborados por el experto Lutz
Scholz, se puede generar y/o verificar la aplicacion de los sub modelos
deterministicos parciales y generar una serie de caudales confiables
aplicando un modelo estocastico; para esto se realizard una revisién de la
fuente bibliogréfica y el analisis del modelo, tomando como base para el
estudio diez subcuencas de la margen derecha del rio Santa que cuenten

con informacion de precipitacion y descarga.



2.2. Bases tedricas
2.2.1. Delimitacion de cuencas con ArcGIS

Segun Puerta, Trigozo y Morales (2013) define al ArcGIS como el
nombre de un conjunto de productos de software en el campo de
los sistemas de informacion geografica o SIG. Producido y
comercializado por ESRI, bajo el nombre genérico ArcGIS se
agrupan varias aplicaciones para la captura, edicion, andlisis,
tratamiento, disefio, publicacion e impresion de informacion
geografica. Estas aplicaciones se engloban en familias tematicas
como ArcGIS server, para la publicacion y gestion web, o ArcGIS
movil para la captura y gestion de informacion en campo.
Delimitar cuencas manualmente suele resultar un trabajo muy
laborioso, sin embargo, ArcGIS cuenta con un potente conjunto de
herramientas hidroldgicas que permiten modelar el flujo de agua a
través de una superficie de un modelo de Elevacion digital (DEM),
que ayudan a tomar decisiones en procesos de planificacion. Para
delimitar automaticamente una cuenca hidrografica y construir la
red hidrica a partir de un DEM, es necesario realizar el siguiente
procedimiento:

- Obtencion del DEM

- Definir Proyeccion del DEM

- Eliminar Imperfecciones del DEM

- Definir la direccion de la Red Hidrica

- Determinar la acumulacién de la Red Hidrica.



- Delimitacién de la cuenca
2.2.2. Parametros de forma

Segin Cahuana y Yugar (2009) indica la importancia de la
configuracién de las cuencas, se trata de cuantificar parametros por
medio de indices o coeficientes, los cuales relacionan el
movimiento del agua y las respuestas de la cuenca a tal movimiento
los principales parametros son los siguientes:

a. Coeficiente de compacidad (Cc).
Segun Cahuana y Yugar (2009) define como el cociente que existe
entre el perimetro de la cuenca respecto al perimetro de un circulo
del area de la misma cuenca, tal como expresa la siguiente formula
(2.2).

P 2
C.= =0.28— 2.1
¢ 2JmA VA (21)

Donde:

Ce: Coeficiente de compacidad.

P: Perimetro de la cuenca, en Km.

A: Area de la cuenca, en km2
Segun Santos (2005) cuanto mas irregular sea la cuenca mayor sera
su coeficiente de compacidad, un coeficiente minimo igual a la
unidad corresponde a una cuenca circular; cuando este nimero

tiende a la unidad hay mayor tendencia a aumentar el caudal.



b. Factor de forma (Ff)
Segln Mejia (2001) define como la expresion cuantitativa de la
forma del contorno de una cuenca, como se expresa en la formula
(2.2).

A/L A
=7 (2.1)

Donde:

Fr. Factor de forma

B: Ancho medio de la cuenca, en Km (B= A/L)

A: Area de la cuenca, en km2

L: Longitud axial de la cuenca, en km
Segun Cahuana y Yugar (2009) esta ecuacién muestra que las
cuencas no son similares en forma. A medida que el &rea aumenta,
su relacion A/L2 disminuye, lo cual indica una tendencia al
alargamiento en cuencas grandes. La forma de la cuenca afecta los
hidrogramas de caudales méaximos, por lo que se han hecho
numerosos esfuerzos para tratar de cuantificar este efecto por
medio de un valor numérico.

c. Coeficiente de forma (Cf)

Segun Cahuana y Yugar (2009). Define como la Relacion entre la
anchura media Bn de la cuenca y la longitud media (Lmc), como
expresa la formula (2.3).

B
Cr = Tm (2.2)



Donde:
Bm = Ancho media de la cuenca
Lmc = Longitud media de la cuenca (distancia entre la salida y el

punto mas alejado de la cuenca).

d. Relacion de elongacion (Re)
Segun Cahuana y Yugar (2009) definen como la relacién entre el
diametro de un circulo (D) de area igual a la cuenca y la longitud
de la cuenca (Lc), como expresa la formula (2.4).

D

== (2.3)

R,

Expresando el didmetro en funcion del area de la cuenca (A) queda:

A
R, = 1.1284% (2.4)

Si Re varia entre 0.60 y 1.00 cuenca con amplia variedad de climas
y geologias. Ademas, esta fuertemente correlacionado con el
relieve de la cuenca, de manera que valores cercanos a la unidad
son tipicos de regiones con relieve bajo, en cambio donde Re que
varia de 0.60 a 0.80 esta asociado a fuertes relieves y pendientes
pronunciadas del terreno, relieves y pendientes pronunciadas del
terreno porque esté entre 0.6 y 0.8.
e. Relacidon de circularidad (Rc)

Segin Cahuana y Yugar (2009) define como relacién de
circularidad, (Rc), denominado también como radio de

circularidad, es el cociente entre el area de la cuenca (A) y la del



circulo cuyo perimetro (P) es igual al de la cuenca, como expresa
la formula (2.6).

4A
C = PZ

(2.5)
Donde:
A=Area de la Cuenca en Km2
P=Perimetro de la cuenca en Km.
Cuando R¢=1, la cuenca es circular y si Rc=0.785, la cuenca es
cuadrada.
2.2.3. Parametros de relieve
Segun Cahuana y Yugar (2009) consideran que para describir el
relieve de una cuenca existen numerosos parametros que han sido

desarrollados por varios autores; entre los mas utilizados son las

siguientes:

a. Altitud media (Am)

Segun Cahuana y Yugar (2009) define como ordenada media de la
curva hipsométrica, en ella, el 50 % del area de la cuenca, esta
situado por encima de esa altitud y el 50 % esta situado por debajo
de ella.

Curva hipsométrica de una cuenca

Segun Cahuana y Yugar (2009) define como la representacion
grafica del relieve de una cuenca; es decir la curva hipsométrica
indica el porcentaje de area de la cuenca o superficie de la cuenca
en km? que existe por encima de una cota determinada,

representado en coordenadas rectangulares.

10



La altitud media se pude calcular con la formula (2.6).

Ya.e
Em == (2.6)

Donde:

Em: Elevacion media

a: Area entre dos contornos

e: Elevacion media entre dos contornos

A: Area total de la cuenca
Gréaficamente la elevacion mediana de la cuenca se obtiene,
entrando con el 50 % del area en el eje X, trazando una
perpendicular por este punto hasta interceptar a la curva
hipsométrica. Luego por este punto se traza una horizontal hasta

cortael eje .

b. Pendiente de la cuenca (S)
Segun Cahuana y Yugar (2009) la pendiente media de la cuenca
tiene una importante pero compleja relacion con la infiltracion, el
escurrimiento superficial, la humedad del suelo y la contribucion
del agua subterrénea al flujo en los cauces. Es uno de los factores
fisicos que controlan el tiempo del flujo sobre el terreno y tiene
influencia directa en la magnitud de las avenidas o crecidas.
Existen diversos criterios para evaluar la pendiente media de una
cuenca, entre las que se destacan son:
Criterio de J.W. Alvord
Cahuana y Yugar (2009). Analiza la pendiente existente entre

curvas de nivel, trabajando con la faja definida por las lineas

11



medias que pasan entre las curvas de nivel, Para una de ellas la

pendiente es:

D.L

=— 2.7

s == (27)

— Dlll + (lz + l3 + S0 i hee s ln—l)Dnln (28)
A

Donde:

Sc: Pendiente de la cuenca

D: Desnivel constante entre curvas de nivel, en km

L: Longitud total de las curvas de nivel dentro de la cuenca, en

km

D1: Desnivel en la parte mas baja, en km

Dn: Desnivel en la parte mas alta, en km

A: Area de la cuenca, en km?
La ecuacion se emplea en el caso en que “D” no sea constante (eso
puede suceder en la parte mas alta y la parte mas baja de la cuenca).
Criterio del rectangulo equivalente
Segun Santos (2005) con este criterio, para hallar la pendiente de
la cuenca, se toma la pendiente media del rectangulo equivalente,

como expresa la formula (2.10)

s = (2.9)

H
L
Donde:

S: Pendiente de la cuenca

H: Desnivel total (cota en la parte mas alta — cota en la estacion

de aforo), en km.

12



L: Longitud mayor del rectangulo equivalente, en km.
Este criterio, no proporciona un valor significativo de la pendiente
de la cuenca, pero puede tomarse como una aproximacion.
c. Pendiente del cauce principal (Sc)
Segun Cahuana y Morales (2009). Define como la relacion entre la
altura total del cauce principal (cota maxima, Hmax menos cota
minima, Hmin) y la longitud del mismo (L), como expresa la

formula (2.11)

S, = FAmax = Hmin (2.10)

2.2.4. Parametros de drenaje

a. Densidad de drenaje (Dd)
(2.11)

Donde:

Dd: Densidad de drenaje (km/km2)

L: Longitud total de corrientes (km)

A: Area de la cuenca (km?)
Segun Santos (2005) la densidad de drenaje, usualmente toma
valores entre 0.5 km/ km? para cuencas con drenaje pobre y hasta

3.4 km/km? para cuencas excesivamente bien drenadas.

b. Relacion de bifurcacion (Rb)
Segun Cahuana y Morales (2009) define como la relacion entre el

namero de cauces de orden i (Ni) y el nimero de cauces de orden

13



i+1 (Ni+1). Horton encontré que esta relacion es relativamente
constante de un orden a otro.

N;

R =
® 7 N

(2.12)

El valor tedrico minimo para Rb es 2 y segun Strahler un valor
tipico se encuentra entre 3 y 5 en cuencas donde la estructura

geoldgica no distorsiona el patron de drenaje natural.

c. Orden de corrientes (Oc)

Segun Reyes (1992) un cauce puede ser tributaria de otra mayor y
asi sucesivamente de manera que por esta razon se les puede
asignar un orden de importancia dentro de la cuenca; una forma
muy utilizada para establecer el orden de las corrientes es teniendo

en cuenta su grado de bifurcacion.

2.2.5. Relaciones empiricas de los parametros geomorfometricos.

a. Ley de Hack.

Donde:

Hack (1957), encontrd una funcion que relaciona la longitud del
canal principal de una cuenca con el area de la misma.

L=CAM (2.13)

L: Longitud de cauce

A: Area de la cuenca

C, h: Parametros de la ecuacion.

14



2.3. Definicion de términos
Acumulacién de flujo
Segln Ruiz y Torres (2010) la acumulacion de flujo es una matriz en la
cual se calcula para cada celda un valor de acumulacién de peso
proveniente de las celdas que fluyen haca ella.
Cuenca hidrogréfica
Segun Perez (2012) define como el espacio de territorio delimitado por la
linea divisoria de las aguas, conformado por un sistema hidrico que
conducen sus aguas a un rio principal.
Delimitacion de cuenca
Segun Perez (2012) tradicionalmente la delimitacion de cuencas, se ha
realizado mediante la interpretacion de los mapas cartograficos. Este
proceso, ha ido evolucionando con la tecnologia. Hoy dia los sistemas de
informacion geografica SIG proporcionan una gama amplia de
aplicaciones y procesos que, con entender los conceptos y teoria, se puede
realizar de una forma mas sencilla y rapida el analisis y delimitacion de
una cuenca.
Direccion de flujo
Segun Ruiz y Torres (2010) la direccién de flujo esta determinado por la
direccién por la direccion mas empinada descendiendo de cada celda o
pixel.
Geomorfometria
Segun Perez (2012) define como el conjunto de técnicas, procedimientos

y metodos, utilizados para determinar atributos configuracionales del
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relieve y, en base a ellos, conocer el sistema de relaciones espaciales que
caracterizan a las formas del terreno

Modelo digital de terreno

Segln Ruiz y Torres (2010) define como una estructura numérica de datos
que representa la distribucion espacial de una variable cuantitativa y
continua, como puede ser temperatura, la altitud o la presion atmosférica.
Sistema de informacion geogréfica

Segun Puerta, Trigozo y Morales (2013) es una integracién organizada de
hardware, software y datos geogréaficos disefiada para capturar, almacenar,
manipular, analizar y desplegar en todas sus formas la informacién
geograficamente referenciada con el fin de resolver problemas complejos

de planificacion y de gestion.
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I1l. METODOLOGIA
3.1. Tipo y disefio de investigacion

3.1.1. Tipo de investigacion

Aplicada, porque segun Bunge (1971), el proposito de este tipo de
investigacion es dar solucidn a situaciones o problemas concretos
e identificables

El nivel de investigacion es descriptivo-correlacional, porque
segun Hernandez (1991), describe como los estudios descriptivos
miden de manera mas bien independiente los conceptos o variables
con las que tiene que ver, los estudios correlacidénales miden las
dos 0 mas variables que se pretende ver si estan o no relacionadas

en los mismos sujetos y después de analizar la correlacién

3.2.2. Disefio de investigacion

El disefio de la investigacion es no experimental, porque segin
Hernandez (1991), define como aquella que se realiza sin
manipular deliberadamente las variables.

Transversal, porque segin Herndndez (1991), los disefios
transversales recolectan datos en un solo momento, en un tiempo
unico. Su propésito es describir variables, y analizar su incidencia

e interrelacion en un momento dado.

3.2. Plan de recoleccidon de la informacion y/o disefio estadistico

a) Poblacion

Para el presente trabajo de investigacion se han considerado las 52 Sub

Cuencas de la Cuenca Marafion tales como Chonchon, Chocta,
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3.3.

3.4.

Sharcote, Sioner, Capillana, Sarin, Urapayacu, Lacla, Lavasen, Gansul,
El Oso, Tigo, Suchaga, Cachipampa, Otubamba, San Miguel, San
Sebastian, Huayllopa, Chinchango, Casga, Rupaybamba, Vincos,
Aguayacu, Mollepampa, Cajas, Atuy, Suyanba, Capillabamba, Potrero,
Arancante, Challas, Repaci, Anchic, Shamalmonte, Manto, Cunyac,
Tangui, Huaylas, Sanachga, Tucumacay, Pauca Chunqui, Tranca,
Pinra, Yupan, Panoragra, Porcato, Puchka, Cuntan, Jaupanga, Jagra,
Tantamayo, Llactar, Picruj, Manish, Aco, Callo, Hambraragra,
Huaspay, Matacac, Vizcarra, Tumahuain, Panavado, Callanca, San

Juan, San Martin, Nupe.

b) Muestra
Para la muestra se ha tomado las 52 subcuencas que describen en la
poblacion, para obtener datos mas confiables para la investigacion.
Instrumentos de recopilacion de la informacion
Los instrumentos que se utilizaran en la investigacion, son la recopilacién
de datos y filtrado de la informacion necesaria que servird dentro de la
investigacion, utilizando materiales y tecnologia que esté a nuestro
alcance.
Plan de procesamiento y analisis estadistico de la informacion
Se aplicaran las siguientes técnicas de procesamiento de datos:
3.4.1. Ordenamientoy clasificacion
Se aplicara para tratar la informacion cualitativa y cuantitativa
sobre temas de delimitacion de subcuencas, parametros

geomorfomeétricos, relacion entre los parametros
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geomorfométricos, en forma ordenada para poder interpretar y

obtener el méaximo provecho.

3.4.2. Registro manual
Se aplicara para digitar la informacion de las diferentes fuentes
sobre temas de delimitacibn de subcuencas, parametros
geomorfomeétricos, relacion entre los parametros

geomorfométricos.

3.4.3. Proceso computarizado a través de generacion de programas
Se elaborard rutinas de programas dentro del software tal es el caso
de ModelBuilder de computo que se ha considerado adecuado para
el trabajo de investigacion, se ha previsto elaborar rutinas de
programas para los siguientes procesos:

v" Delimitacion de las Subcuencas
v/ Andlisis 'y procesamiento de los  parametros
geomorfométricos

3.4.4. Proceso computarizado con un software comercial
Se aplicara un software comercial para el analisis y calculo de todos
los parametros que intervienen dentro de la investigacion.

3.5. Técnicas de analisis de la informacion

3.5.1. Delimitacién de las subcuencas

La técnica de analisis para la delimitacion de las subcuencas se

realizara siguiendo el diagrama de flujo.
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Obtenci6n de datos
SRTMy pre -
procesamiento

Direccion
de fluio

Acumulacion de
flujo y calculo del
umbral

Red de
drenaje

Generacion
de cuencas

Vectorizacion
y codificacion

Figura 3.1. Diagrama de flujo de la delimitacion de las
subcuencas
Fuente: Elaboracion propia

a. Obtencidn de datos SRTM y procesamiento

Los datos altimétricos de 30 metros de resolucion espacial
correspondiente al DEM del area de estudio, se ha realizado desde
la pagina Wed http://earthexplorer.usgs.gov.

El pre-procesamiento consiste en la eliminacion de imperfecciones
de fuente de origen presentes en el DEM, dentro de los cuales se
encuentran las zonas sin datos o vacias “No Data”, que segin Olaya
(2011) deben corregirse aplicando métodos de interpolacion. Otro
factor que afecta la calidad de los datos SRTM, es la presencia de
picos y sumideros, que de acuerdo a Medeiros (2009), las
imperfecciones presentes en el modelo de datos ocasionan errores
en el mapa de la direccion de flujo.

Una de las formas de eliminar la presencia de valores No Data en
el modelo es mediante estadisticas focales, procedimiento que se
efectla a través de la herramienta ArcToolbox>Spatial Analyst
Tools>Map Algebra>Raster Calculator. Posteriormente se
corrigen los picos y sumideros a través del recurso Spatial

Analyst>Hidrology>Fill.
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b. Direccién de flujo
En esta etapa se obtiene un raster con las orientaciones de flujo de
cada celda vecina, calculadas en funcion a las pendientes.
Walchholz et al. (2013), menciona que las direcciones de flujo
expresan las relaciones hidrolégicas entre diferentes puntos de una
cuenca hidrografica.
Para ESRI (2013), el célculo de direccion de flujo es un proceso

sigue la secuencia mostrada en la Figura.

TE| 72|69 71|58]|49
T4167| 5649 46| 50
6953|441 37|38| 48
6458552231 |24
68|61|47]21| 16|19
T4153134) 121112

Elevation surface

Direction coding

Figura 3.2. Procedimiento de calculo de direccion de flujo
Fuente: ESRI 2013

La direccién de flujo se obtiene a través del recurso

ArcToolbox>Spatial Analyst>Hidrology>Flow Direction.

c. Acumulacion de flujo y célculo del umbral
La acumulacion de flujo determina todas las celdas que drenan a
una en particular, la cual se obtiene a partir de la direccion de flujo.
Segun Venkatachalam et al. (2001), la acumulacion de flujo en una
celda se establece en funcion a la suma de los valores de

acumulacion de flujo de las celdas vecinas que desembocan en ella.
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De acuerdo a ESRI (2013), la acumulacion de flujo es un proceso

que sigue la secuencia especificada en la Figura.

=10 B =1 B =

=T -0 I T

=1 B

1124
41 7]35] 2

L= I = By I = B = B B =0 I =]

Lol =R I

Flow accumulation

Direction coding

Figura 3.3. Procedimiento de calculo de acumulacion de flujo.
Fuente: ESRI 2013

La acumulacion de flujo se obtiene a través del recurso
ArcToolbox>Spatial Analyst>Hidrology>Flow Acumulation.
ESRI (2012), para el calculo del umbral se requiere del raster de
acumulacion de flujo y la cantidad minima de celdas que forman el
curso de agua, las cuales corresponden al valor del umbral. De
acuerdo a la UICN (2009a), se obtiene mediante un procedimiento
repetitivo de ensayo y error, con el cual se determina el umbral de
acumulacion que permite identificar el afluente principal y cuatro
aportantes. Con los resultados se determinan las 4 unidades de
drenaje tipo cuenca y 5 de tipo intercuenca, correspondiéndoles a
las primeras las mayores areas de drenaje y acumulacion de flujo
segun el método Pfafstetter.

En ArcGIS el proceso se realiza desde ventana

Layer>Properties>Symbology>Classified>Classify, donde se
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especifica la clasificacion en dos rangos o clases aplicando el
método Natural Breaks - Jenks; el primero va de 1 a N valor
calculado por la herramienta, mientras que el segundo del N valor
al nimero maximo que alcanza la acumulacion de flujo. El valor N
es con el cual se realizan los ensayos a través de la opcién
Classify>Break Value.
El céalculo del umbral finaliza con la reclasificacion de los
resultados obtenidos, y se realiza por medio de la herramienta
ArcToolbox>Spatial Analyst Tools>Reclass>Reclassify,
asignandole el valor de 0 al primer rango y 1 al segundo rango,
siendo el segundo rango el requerido para la siguiente etapa del
proceso, ya que almacena los afluentes principales. (UICN Sur &
SGCAN, 2010)

d. Red de drenajes
La generacion de la red de drenajes es fundamental para la
determinacion de las cuencas hidrograficas, el insumo principal en
esta etapa es la reclasificacion de la acumulacién del rango cuyo
valor asignado fue 1 en la anterior fase.
El procedimiento se realiza desde la caja de herramientas
ArcToolbox>Spatial Analyst Tools>Hydrology>Stream Link.
Segun criterio de Johnson (2008), Stream Link asigna valores
unicos a las secciones de una red de drenajes entre las

intersecciones, que para la UICN (2009), los enlaces o links son los
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segmentos de una red de drenajes que conectan a dos aportantes de

forma sucesiva.

e. Generacion de cuencas

Segun Alves et al. (2010), el proceso para la generacion de las areas
de drenaje requiere del mapa de direccion y acumulacion de flujo
y se lo realiza mediante la herramienta ArcToolbox>Spatial
Analyst Tools>Hydrology>Wathershed.

Para UICN (2009b), Wathershed establece el area aportante de la
cuenca que drena dentro de ella y fluye a una determinada salida.

f. Vectorizacion y codificacion

La vectorizacion consiste en convertir las cuencas de formato raster
a vector. Es la etapa final de la metodologia y arroja como resultado
el archivo shapefile con los poligonos de las unidades hidrogréficas
delimitadas. De acuerdo a lo establecido por la UICN (2009) en el
manual de procedimientos de delimitacion y codificacion de
unidades hidrograficas para el Ecuador, la vectorizacion de las
cuencas se logra a través de la siguiente herramienta
ArcToolbox>Conversion Tools>From Raster>Raster To Polygon.
La codificacion de cuencas hidrograficas basadas en el método
Pfafstetter (1989), es jerarquica y utiliza 10 digitos relacionados
directamente con el area de drenaje y cursos de agua. Segun Galvéo
& Meneses (2005), los codigos pares 2, 4, 6 y 8 se asignan a las
cuatro cuencas principales a las cuales corresponden las mayores

areas de drenaje, mientras que las intercuencas identifican a las
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cinco unidades de drenaje de menor tamafio y reciben los digitos 1,
3, 5, 7y 9. La Secretaria del Ambiente (2011), corrobora lo
manifestado por los autores anteriormente, pero ademéas manifiesta
que en caso de existir intercuencas, estas se codifican con el digito

0, como se puede observar en la Figura.

Figura 3.4. Codificacion del método Pfasfstetter.
Fuente: ESRI 2013

El proceso de codificacion se realiza desde aguas abajo

(desembocadura), hacia aguas arriba (naciente de la cuenca).
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PROJECCION CORRECION DE
RASTER VACIOS

Figura 3.5. Procedimiento para la correccion de DEM de la cuenca del Marafion
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CALCULO DE
FLUJO
ACUMULADO
CALCULO DE
DIRECCION DE
FLUJO

DATO NO
UTILIZADO

Figura 3.6. Procedimiento para el calculo del umbral
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Figura 3.7. Procedimiento para la obtencién de las subcuencas de la cuenca de la Marafion
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3.5.2. Determinacion de los parametros geomorfometricos.
a. Parametros de forma
Estos parametros se determinaron aplicando las férmulas
existentes, las caracteristicas de las sub cuencas tales como el érea,
perimetro, longitud, etc, que son insumos necesarios para el calculo
de los parametros de forma, se determiné utilizando el software
ArcGIS y para la solucion de las férmulas se empleard el software

Excel.

b. Pardmetros de relieve
Estos parametros se determinaron aplicando en mayor parte el
software ArcGIS ya que brinda una cantidad de herramientas Utiles
para procesar los datos de este tipo, se elaborara rutinas de
programas dentro del software tal es el caso de ModelBuilder,
obteniendo los datos primarios para que posteriormente sean

procesados en el software excel para un andlisis mas detallado.
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ANALISIS
ESTADISTICO

Figura 3.8. Procedimiento para la obtencion de datos para las Curvas Hipsométricas de las subcuencas de la cuenca del Marafion
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INTERPOLACION
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J‘\.\“ ANALISIS
ESTADISTICO
CALCULO DE

PENDIENTES

Figura 3.9. Procedimiento para la obtencion de la pendiente media de la cuenca y el cauce principal de las subcuencas de la cuenca del
Marafion
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c. Parametros de drenaje
Estos pardmetros seran determinados aplicando el software

ArcGIS y para la solucion de las ecuaciones sera necesario el uso

del software excel.

N

EXTRACCION
POR MASCARA

Figura 3.10. Procedimiento para extraccion del flujo acumulado de las
subcuencas de la cuenca del Marafion

&

CALCULADORA
DE RASTER

Figura 3.11. Procedimiento para el céalculo de red de drenaje de las subcuencas

32




Figura 3.12. Procedimiento para el calculo del orden de corrientes de las subcuencas de la cuenca del Marafion
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3.5.2. Relacion de los parametros geomorfométricos
Se busco la correlacion entre los parametros geomorfométricos,
aplicando la correlacién de Pearson y el analisis de componente
principal, para lo cual en el primer paso se determind la correlacién
de las parametros, analizando que parametros son dependientes
unas de otras, después de definir la dependencia se obtuvo las
diversas ecuaciones de regresion, tales como ecuacion de regresion
lineal, ecuacion de regresion exponencial, ecuacién de regresion
logaritmica, ecuacion potencial de regresion y ecuacion polinébmica
de regresion, segun sea el caso para, facilitar los calculos se empled

el software SPSS.
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IV. RESULTADOS

4.1. Delimitacién de las subcuencas

Para la delimitacién de las subcuencas de la cuenca del Marafion, se utilizé

el software ArcGIS versién 10.3 en la cual se realiz6 los siguientes

procesos:

4.1.1. Obtencion de datos SRTM y procesamiento

Una vez obtenido los datos de la pagina web

http://earthexplorer.usgs.gov. Se procede al procesamiento de los

datos, para la cual se implement6 una rutina en el ModelBuilder
del software ArcGIS 10.3 para facilitar todo el proceso.
El proceso consistio en los vacios “No Data” y los picos y

sumideros que trae el DEM original.

4.1.2. Direccion de flujo

Una vez obtenido el DEM corregido, se implementd una rutina en
el ModelBuilder del software ArcGIS 10.3 para el calculo de la

direccion de flujo.

4.1.3. Acumulacion de flujo y célculo del umbral

4.1.4.

Una vez obtenido el DEM corregido, se implementd una rutina en
el ModelBuilder del software ArcGIS 10.3 para el calculo de
acumulacion de flujo y calculo del umbral.

Red de drenajes

Una vez calculado el raster de la direccién de flujo, raster de flujo

acumulado y el umbral adecuado, se implement6 una rutina en el
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ModelBuilder del software ArcGIS 10.3 para el célculo red de
drenajes.

4.1.5. Generacion de cuencas
Con los datos obtenido en los procesos anteriores se elaboré una
rutina en el Modelbuilder para la obtencién de las subcuencas,
siguiendo los procedimientos necesarios para la obtencién de los

datos con lo cual se obtuvo 52 subcuencas de nivel 7.

4.1.6. Vectorizaciony codificacion

En este proceso se utilizd la informacion generada en las etapas
anteriores, es decir la cartografia validada, el modelo de elevacion
digital.

Para la delimitacion segun Pfasftetter, se subdividié las cuencas
hidrogréficas, identificando los cuatro mayores afluentes en
términos de area y longitud al rio principal luego se proyecté hasta
el limite de la cuenca mayor para obtener las intercuencas.

Las codificaciones de las cuencas correspondientes a esos
tributarios son enumeradas con los digitos pares (2, 4, 6 y 8),
iniciando en la desembocadura y siguiendo el rio principales aguas
arriba hasta la naciente del rio principal. Los otros tributarios del
rio principal son agrupados como areas restantes y denominadas
intercuencas, cuya numeracion es asignada con los digitos impares
(1, 3,5, 7y9). En el caso de encontrar una cuenca gque no tiene
afluentes hacia el rio principal se le denomina cuenca endorreica o

interna y lleva por codificacion cero.

36



Tabla 4.1. Codificacién de las subcuencas de la cuenca del Marafion

Subcuenca Nivel 1 Nivel 2 Nivel 3 Nivel 4 Nivel 5 Nivel 6 Cddigo
ACO 4 49 498 4989 49899 498997 | 4989976
ACTUY 4 49 498 4989 49899 498993 | 4989936
ANCHIC 4 49 498 4989 49899 498993 | 4989939
ANDACHUPA 4 49 498 4989 49899 498998 | 4989983
BATAN 4 49 498 4989 49899 498997 | 4989977
CAJAS 4 49 498 4989 49899 498993 | 4989934
CANCHIS 4 49 498 4989 49899 498997 | 4989972
CERPAQUINO 4 49 498 4989 49899 498992 | 4989924
CHIRIMACHAY 4 49 498 4989 49899 498993 | 4989931
CHOCTA 4 49 498 4989 49899 498991 | 498991
CHULLPA 4 49 498 4989 49899 498996 | 4989961
COCHABAMBA 4 49 498 4989 49899 498992 | 4989922
COLCA 4 49 498 4989 49899 498996 | 4989962
CUNYA 4 49 498 4989 49899 498994 | 4989946
CUNYAC 4 49 498 4989 49899 498999 | 4989994
HUACHIMIN 4 49 498 4989 49899 498992 | 4989921
HUACOTO 4 49 498 4989 49899 498998 | 4989984
HUACRACHUCO 4 49 498 4989 49899 498993 | 49899310
HUANCAS 4 49 498 4989 49899 498993 | 4989937
HUANGOR 4 49 498 4989 49899 498997 | 4989975
HUASHPAY 4 49 498 4989 49899 498997 | 4989978
HUAYHUASH 4 49 498 4989 49899 498999 | 4989997
HUINCHUS 4 49 498 4989 49899 498993 | 4989932
ICHICYACU 4 49 498 4989 49899 498998 | 4989981
LAMPAS 4 49 498 4989 49899 498998 | 4989985
LAURICOCHA 4 49 498 4989 49899 498999 | 4989998
LINDA 4 49 498 4989 49899 498999 | 4989999
MANISH 4 49 498 4989 49899 498997 | 4989974
MARANON 4 49 498 4989 49899 498993 | 49899311
MARIA HUAITA 4 49 498 4989 49899 498994 | 4989945
MATACAC 4 49 498 4989 49899 498999 | 4989991
MOSNA 4 49 498 4989 49899 498996 | 4989967
NUPE 4 49 498 4989 49899 498999 | 4989996
NUPE NUPE 4 49 498 4989 49899 498999 | 4989995
POMABAMBA 4 49 498 4989 49899 498994 | 4989944
PUCHCA 4 49 498 4989 49899 498996 | 4989963
PUCROJ 4 49 498 4989 49899 498997 | 4989973
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Tabla 4.1. Codificacion de las subcuencas de la cuenca del Maraién

Subcuenca Nivel 1 Nivel 2 Nivel 3 Nivel 4 Nivel 5 Nivel 6 Cddigo
PURHUAY 4 49 498 4989 49899 498996 | 4989965
RANCASA 4 49 498 4989 49899 498997 | 4989971
RUNICHINCHAY 4 49 498 4989 49899 498996 | 4989966
RUPAC 4 49 498 4989 49899 498993 | 4989938
SAN JUAN 4 49 498 4989 49899 498999 | 4989992
SAN MARTIN 4 49 498 4989 49899 498999 | 4989993
SAN NICOLAS 4 49 498 4989 49899 498994 | 4989942
SARIN 4 49 498 4989 49899 498992 | 4989923
SHIUSHA 4 49 498 4989 49899 498996 | 4989964
SHUYANGA 4 49 498 4989 49899 498993 | 4989935
TAPARACO 4 49 498 4989 49899 498998 | 4989982
TRANCA 4 49 498 4989 49899 498995 | 498995
UCTUBAMBA 4 49 498 4989 49899 498993 | 4989933
YANAMAYO 4 49 498 4989 49899 498994 | 4989941
YURMA 4 49 498 4989 49899 498994 | 4989943

4.2. Determinacion de los pardmetros geomorfométricos
4.2.1 Parametros de forma
Los parametros de forma se han determinado de acuerdo a las
férmulas tedricas y utilizando el software ArcGIS y Excel, los

resultados se muestran en la siguiente tabla:
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Tabla 4.2. Parametros de forma de las subcuencas de la cuenca de Marafion

Longitud | Anchodela | Coeficiente de | Factor de | Coeficiente Relacion de Relacion de
Subcuenca Area (km?) Perimetro (km) del rio- Lc | cuenca-B. | Compacidad Forma de Forma Elongacion | Circularidad

(km) (km) (Co) (Ff) (Ch (Re) (Re)
Aco 242.40 85.39 20.01 20.96 1.54 0.61 1.05 0.96 0.42
Actuy 460.03 118.02 35.17 20.28 1.54 0.37 0.58 0.75 0.42
Anchic 251.67 94.70 27.72 15.37 1.67 0.33 0.55 0.70 0.35
Andachupa 306.49 96.91 31.20 15.22 1.55 0.31 0.49 0.69 0.41
Batan 136.04 83.82 6.65 29.60 2.01 3.08 4.45 2.15 0.24
Cajas 752.31 197.15 59.64 24.27 2.01 0.21 0.41 0.56 0.24
Canchis 166.93 70.75 20.54 13.94 1.53 0.40 0.68 0.77 0.42
Cerpaquino 155.28 66.81 21.78 14.14 1.50 0.33 0.65 0.70 0.44
Chirimachay 1286.74 192.25 43.74 37.91 1.50 0.67 0.87 1.01 0.44
Chocta 409.95 101.53 23.83 28.11 1.40 0.72 1.18 1.04 0.50
Chullpa 727.61 134.97 29.72 32.09 1.40 0.82 1.08 1.11 0.50
Cochabamba 467.30 123.54 24.26 31.20 1.60 0.79 1.29 1.09 0.38
Colca 319.11 98.36 32.45 18.42 1.54 0.30 0.57 0.68 0.41
Cunya 577.22 111.81 21.01 30.36 1.30 1.31 1.45 1.40 0.58
Cunyac 352.51 118.71 28.75 22.62 1.77 0.43 0.79 0.80 0.31
Huachimin 531.75 118.28 35.57 23.05 1.44 0.42 0.65 0.80 0.48
Huacoto 384.53 124.50 22.35 40.25 1.78 0.77 1.80 1.08 0.31
Huacrachuco 403.40 126.78 33.77 19.72 1.77 0.35 0.58 0.73 0.32
Huancas 496.36 115.66 25.90 33.37 1.45 0.74 1.29 1.06 0.47
Huangor 270.20 89.64 26.79 16.67 1.53 0.38 0.62 0.75 0.42
Huashpay 146.15 69.76 19.94 8.52 1.62 0.37 0.43 0.74 0.38
Huayhuash 175.82 80.43 24.20 10.24 1.70 0.30 0.42 0.67 0.34
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Tabla 4.2. Parametros de forma de las subcuencas de la cuenca de Marafion

, Longus | Ao | Coeente | Fetor | Coeint | Bttt | e
Subcuenca Area (km?) Perimetro (km) | delrio- Lc | lacuenca (F():C) Forma () (|ge) (Ro)
(km) - Bc (km) (Ff)

Huinchus 477.12 114.80 32.16 32.80 1.47 0.46 1.02 0.83 0.45
Ichicyacu 490.80 143.60 41.82 38.73 1.81 0.28 0.93 0.65 0.30
Lampas 231.96 90.55 29.34 11.97 1.66 0.27 0.41 0.64 0.36
Lauricocha 424.48 114.97 33.27 21.43 1.56 0.38 0.64 0.76 0.40
Linda 255.98 85.15 22.34 14.24 1.49 0.51 0.64 0.88 0.44
Manish 140.72 78.89 18.34 14.87 1.86 0.42 0.81 0.79 0.28
Maranon 1112.31 182.00 50.63 47.70 1.53 0.43 0.94 0.81 0.42
Maria Huaita 252.09 81.63 28.24 10.79 1.44 0.32 0.38 0.69 0.48
Matacac 516.28 138.68 25.58 33.30 1.71 0.79 1.30 1.09 0.34
Mosna 1017.80 162.20 45.30 47.41 1.42 0.50 1.05 0.87 0.49
Nupe 300.76 84.56 19.23 23.10 1.37 0.81 1.20 111 0.53
Nupe 316.68 103.66 23.63 28.07 1.63 0.57 1.19 0.93 0.37
Pomabamba 645.39 131.76 37.03 26.44 1.45 0.47 0.71 0.84 0.47
Puchca 226.13 74.83 17.39 16.52 1.39 0.75 0.95 1.06 0.51
Pucroj 312.85 83.22 18.47 20.50 1.32 0.92 111 1.18 0.57
Purhuay 149.56 64.54 17.52 15.76 1.48 0.49 0.90 0.86 0.45
Rancasa 577.27 178.29 53.83 21.39 2.08 0.20 0.40 0.55 0.23
Runichinchay 196.33 63.88 21.17 1451 1.28 0.44 0.69 0.81 0.60
Rupac 966.80 174.12 41.82 35.03 1.57 0.55 0.84 0.91 0.40
San Juan 168.55 62.38 20.71 13.89 1.35 0.39 0.67 0.77 0.54
San Martin 294.25 104.48 17.58 31.72 1.71 0.95 1.80 1.20 0.34
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Tabla 4.2. Parametros de forma de las subcuencas de la cuenca de Marafion

Longitud | Anchodela | Coeficiente de | Factor de | Coeficiente | Relacion de | Relacion de

Subcuenca Area (km?) Perimetro (km) | delrio-Lc | cuenca-B: | Compacidad Forma de Forma Elongacion | Circularidad
(km) (km) (Co) (Ff) (Ch) (Re) (Re)
San Nicolas 258.48 88.64 26.84 17.62 1.54 0.36 0.66 0.74 0.41
Sarin 170.61 67.31 22.57 11.06 1.44 0.33 0.49 0.71 0.47
Shiusha 156.31 62.95 20.28 10.72 1.41 0.38 0.53 0.76 0.50
Shuyanga 66.23 46.44 6.80 18.53 1.60 1.43 2.73 1.47 0.39
Taparaco 184.51 97.45 31.42 9.05 2.01 0.19 0.29 0.53 0.24
Tranca 752.81 174.25 35.57 46.90 1.78 0.59 1.32 0.95 0.31
Uctubamba 1364.34 200.14 48.54 33.30 1.52 0.58 0.69 0.93 0.43
Yanamayo 221.95 87.27 16.09 24.20 1.64 0.86 1.50 1.14 0.37
Yurma 385.73 112.44 32.72 24.62 1.60 0.36 0.75 0.74 0.38
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4.2.2. Parametros de relieve
Los parametros de relieve se han determinado de acuerdo a las
férmulas teoricas y utilizando el software ArcGIS y exel, los

resultados se muestran en la tabla siguiente:
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Tabla 4.3. Parametros de relieve de las subcuencas de la cuenca de Marafion

Altitud (m.s.n.m.) Altitud mas Pendiente de cuenca (%) Pendiente del
Subcuenca - . - - X
Min. Max. Medio frecuente Min MAXx. Medio cauce (%)
Aco 2979.00 4555.00 3980.97 3962.79 0.00 82.30 33.72 33.72
Actuy 1639.00 4715.00 3762.52 4083.15 0.00 92.10 47.03 47.03
Anchic 2381.00 4504.00 3479.38 2408.87 0.00 64.23 48.77 48.77
Andachupa 3357.00 4940.00 4315.78 434753 0.00 72.30 41.32 41.32
Batan 2979.00 4707.00 3921.83 3925.17 0.00 345.94 36.75 36.75
Cajas 1637.00 4658.00 3674.63 4025.62 0.00 82.32 49.30 49.30
Canchis 2979.00 4568.00 4132.60 4101.57 0.00 73.20 40.07 40.07
Cerpaquino 2556.00 4637.00 3797.61 4026.28 0.00 86.14 44.85 44.85
Chirimachay 1119.00 4553.00 2939.89 3841.27 0.00 83.21 58.00 58.00
Chocta 1049.00 4247.00 2804.72 3830.20 0.00 98.12 63.62 63.62
Chullpa 2381.00 4749.00 3745.20 4423.88 0.00 87.23 44.03 44.03
Cochabamba 2005.00 4281.00 3496.36 2671.34 0.00 60.23 35.88 35.88
Colca 2429.00 5052.00 4144.75 4288.96 0.00 81.23 45.39 45.39
Cunya 2596.00 6129.00 4370.41 4498.67 0.00 95.06 53.80 53.80
Cunyac 3370.00 4429.00 3975.44 4031.72 0.00 56.23 32.72 32.72
Huachimin 1119.00 4357.00 2849.04 2604.55 0.00 97.25 54.96 54.96
Huacoto 3357.00 5272.00 4396.21 4391.71 0.00 95.95 43.60 43.60
Huacrachuco 2381.00 4693.00 3719.14 4016.30 0.00 67.06 49.87 49.87
Huancas 1639.00 4485.00 3149.29 3658.18 0.00 69.63 49.19 49.19
Huangor 2979.00 4713.00 4115.95 4352.30 0.00 73.23 42.49 42.49
Huashpay 2979.00 4763.00 4147.25 4390.27 0.00 64.03 44.69 44.69
Huayhuash 3663.00 5922.00 4545.82 4505.75 0.00 94.66 46.59 46.59
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Tabla 4.3. Parametros de relieve de las subcuencas de la cuenca de Marafion

Altitud (m.s.n.m.) Altitud mas Pendiente de cuenca (%) Pendiente del
Subcuenca ; - . .
Min. Max. Medio frecuente Min. Max. Medio cauce (%)
Huinchus 1279.00 4578.00 3526.29 3906.14 0.00 78.37 56.34 56.34
Ichicyacu 2979.00 4513.00 3862.71 3681.70 0.00 80.44 33.02 33.02
Lampas 3336.00 4856.00 4289.66 4409.37 0.00 78.20 33.80 33.80
Lauricocha 3678.00 5582.00 4434.36 4388.13 0.00 64.10 35.29 35.29
Linda 3678.00 4603.00 4234.88 4257.52 0.00 75.62 31.67 31.67
Manish 2979.00 4590.00 4048.45 4250.16 0.00 63.21 36.84 36.84
Maranon 2381.00 4643.00 3443.95 2409.00 0.00 95.35 46.59 46.59
Maria Huaita 2388.00 4761.00 3766.83 4260.97 0.00 58.33 38.03 38.03
Matacac 2979.00 4946.00 4017.42 4036.22 0.00 82.14 39.55 39.55
Mosna 2753.00 6287.00 4410.72 4390.29 0.00 50.29 46.90 46.90
Nupe 3663.00 6477.00 4571.54 4475.39 0.00 63.53 43.49 43.49
Nupe Nupe 3370.00 4680.00 4062.94 4191.63 0.00 76.35 30.32 30.32
Pomabamba 2381.00 5901.00 3880.32 3998.79 0.00 79.05 41.04 41.04
Puchca 2430.00 5055.00 3624.60 341451 0.00 86.64 54.78 54.78
Pucroj 2979.00 4635.00 3957.22 4290.60 0.00 66.06 41.68 41.68
Purhuay 2892.00 5548.00 4317.47 4330.50 0.00 83.23 50.65 50.65
Rancasa 2381.00 4668.00 3705.04 4178.72 0.00 92.12 49.22 49.22
Runichinchay 2753.00 6160.00 4340.35 5443.95 0.00 88.63 58.85 58.85
Rupac 2381.00 4622.00 3607.24 4153.54 0.00 62.45 42.66 42.66
San Juan 3137.00 4679.00 4113.22 4229.82 0.00 87.23 40.95 40.95
San Martin 3137.00 4372.00 3898.94 3910.22 0.00 76.14 35.92 35.92
San Nicolas 2381.00 4456.00 3684.88 4196.02 0.00 76.75 44.61 44.61
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Tabla 4.3. Parametros de relieve de las subcuencas de la cuenca de Marafidn

Altitud (m.s.n.m.) Altitud mas Pendiente de cuenca (%) Pendiente del
Subcuenca : : ; ;
Min. Max. Medio frecuente Min. Max. Medio cauce (%)
Sarin 2556.00 4410.00 3798.05 4169.82 0.00 70.14 38.57 38.57
Shiusha 2892.00 4599.00 4061.20 4250.08 0.00 65.28 35.21 35.21
Shuyanga 1637.00 4230.00 2825.80 1718.20 0.00 58.63 44.14 44.14
Taparaco 3295.00 4797.00 4231.11 4234.14 0.00 99.05 35.65 35.65
Tranca 2381.00 4893.00 3685.90 4165.04 0.00 48.76 46.72 46.72
Uctubamba 1279.00 4903.00 3374.30 4127.29 0.00 95.70 55.48 55.48
Yanamayo 2381.00 4358.00 3402.01 241541 0.00 88.95 45.46 45.46
Yurma 2381.00 6139.00 4084.03 4103.34 0.00 73.52 52.92 52.92
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4.2.3. Determinacion de los parametros de drenaje

Los parametros de drenaje se han determinado de acuerdo a las

férmulas tedricas y utilizando el software ArcGIS y Excel, los

resultados se muestran en la tabla siguiente:
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Tabla 4.4. Pardmetros de drenaje de las subcuencas de la cuenca de Marafion

Sub cuencas Densidad de drenaje _ Relaci_Qn de O_rden de
Dd (km?/km) bifurcacion (Rb) | corrientes (Oc)
Aco 0.32 3.53 3.00
Actuy 0.28 3.93 4.00
Anchic 0.32 2.37 3.00
Andachupa 0.29 3.83 3.00
Batan 0.33 4.20 3.00
Cajas 0.28 4.20 3.00
Canchis 0.31 2.74 3.00
Cerpaquino 0.30 2.33 3.00
Chirimachay 0.31 2.25 4.00
Chocta 0.30 2.87 3.00
Chullpa 0.31 2.39 3.00
Cochabamba 0.32 3.41 4.00
Colca 0.28 3.29 3.00
Cunya 0.29 2.04 4.00
Cunyac 0.31 2.08 3.00
Huachimin 0.27 2.16 3.00
Huacoto 0.29 2.24 3.00
Huacrachuco 0.32 2.53 3.00
Huancas 0.27 3.30 3.00
Huangor 0.32 3.25 3.00
Huashpay 0.33 2.40 2.00
Huayhuash 0.30 4.00 3.00
Huinchus 0.29 2.32 3.00
Ichicyacu 0.31 2.21 4.00
Lampas 0.32 3.28 3.00
Lauricocha 0.32 2.20 3.00
Linda 0.29 3.50 3.00
Manish 0.33 2.33 3.00
Maranon 0.31 2.58 4.00
Maria Huaita 0.25 2.68 3.00
Matacac 0.25 2.68 3.00
Mosna 0.28 2.27 4.00
Nupe 0.30 2.17 3.00
Nupe Nupe 0.07 2.33 3.00
Pomabamba 0.29 2.02 4.00
Puchca 0.29 2.23 3.00
Pucroj 0.31 2.33 3.00
Purhuay 0.32 2.28 3.00
Rancasa 0.32 2.16 4.00
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Tabla 4.4. Parametros de drenaje de las subcuencas de la cuenca de Marafion

Sub cuencas Densidad de drenaje - _ Relaci_Qn de O_rden de
Dd (km?/km) bifurcacion (Rb) | corrientes (Oc)
Runichinchay 0.29 3.50 3.00
Rupac 0.06 3.50 3.00
San Juan 0.30 3.03 3.00
San Martin 0.28 2.13 3.00
San Nicolas 0.28 2.10 3.00
Sarin 0.28 2.67 2.00
Shiusha 0.27 2.25 3.00
Shuyanga 0.35 3.00 2.00
Taparaco 0.29 3.33 2.00
Tranca 0.30 2.26 4.00
Uctubamba 0.26 2.01 4.00
Yanamayo 0.31 2.52 3.00
Yurma 0.28 2.08 3.00
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Tabla 4.5. Parametros geomorfomeétricos de las subcuencas de la cuenca de Marafion

Parametros de forma

Parametros de relieve

Parédmetros de drenaje

Subcuenca Coeficien_te de Factor de Coeficiente Relacién_ ge F_%elacién de AI_titud Pendiente ZZTg;eun:: Dgr;zlndaa};i _de R_elaci()n_ Qe Ord_en de
compacidad forma (Ff) de forma | elongacion | circularidad | media - Am | de la cuenca principal - Dd bifurcaciéon | corrientes
(Co) (Cf) (Re) (Re) (m.s.n.m.) - S (%) Sc (%) (km?/km) (Rb) (Oc)
Aco 1.54 0.61 1.05 0.96 0.42 3980.97 33.72 30.35 0.32 3.53 3
Actuy 1.54 0.37 0.58 0.75 0.42 3762.52 47.03 42.33 0.28 3.93 4
Anchic 1.67 0.33 0.55 0.70 0.35 3479.38 48.77 43.89 0.32 2.37 3
Andachupa 1.55 0.31 0.49 0.69 0.41 4315.78 41.32 37.18 0.29 3.83 3
Batan 2.01 3.08 4.45 2.15 0.24 3921.83 36.75 33.07 0.33 4.20 3
Cajas 2.01 0.21 0.41 0.56 0.24 3674.63 49.30 44.37 0.28 4.20 3
Canchis 1.53 0.40 0.68 0.77 0.42 4132.60 40.07 36.06 0.31 2.74 3
Cerpaquino 1.50 0.33 0.65 0.70 0.44 3797.61 44.85 40.36 0.30 2.33 3
Chirimachay 1.50 0.67 0.87 1.01 0.44 2939.89 58.00 52.20 0.31 2.25 4
Chocta 1.40 0.72 1.18 1.04 0.50 2804.72 63.62 57.26 0.30 2.87 3
Chullpa 1.40 0.82 1.08 111 0.50 3745.20 44.03 39.63 0.31 2.39 3
Cochabamba 1.60 0.79 1.29 1.09 0.38 3496.36 35.88 32.29 0.32 3.41 4
Colca 1.54 0.30 0.57 0.68 0.41 4144.75 45.39 40.85 0.28 3.29 3
Cunya 1.30 1.31 1.45 1.40 0.58 4370.41 53.80 48.42 0.29 2.04 4
Cunyac 1.77 0.43 0.79 0.80 0.31 3975.44 32.72 29.45 0.31 2.08 3
Huachimin 1.44 0.42 0.65 0.80 0.48 2849.04 54.96 49.47 0.27 2.16 3
Huacoto 1.78 0.77 1.80 1.08 0.31 4396.21 43.60 39.24 0.29 2.24 3
Huacrachuco 1.77 0.35 0.58 0.73 0.32 3719.14 49.87 44.88 0.32 2.53 3
Huancas 1.45 0.74 1.29 1.06 0.47 3149.29 49.19 44.27 0.27 3.30 3
Huangor 1.53 0.38 0.62 0.75 0.42 4115.95 42.49 38.24 0.32 3.25 3
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Tabla 4.5. Parametros geomorfomeétricos de las subcuencas de la cuenca de Marafién

Parametros de forma

Parametros de relieve

Parédmetros de drenaje

Subcuenca Coeficien_te de Factor de Coeficiente Relacién_ ge F_%elacién de AI_titud Pendiente ZZTg;eun:: Dgr;zlndaa};i _de R_elaci()n_ Qe Ord_en de
com(pgé:)ldad forma (Ff) de(fg;)ma eIorzchlon cwcngg)ldad T%d;an_rﬁr;] de_l:;c(gz?ca principal - Dd blfu(gg)cmn cor(gir;tes
S Sc (%) (km?/km)
Huashpay 1.62 0.37 0.43 0.74 0.38 4147.25 44.69 40.22 0.33 2.40 2
Huayhuash 1.70 0.30 0.42 0.67 0.34 4545.82 46.59 41.93 0.30 4.00 3
Huinchus 1.47 0.46 1.02 0.83 0.45 3526.29 56.34 50.71 0.29 2.32 3
Ichicyacu 1.81 0.28 0.93 0.65 0.30 3862.71 33.02 29.72 0.31 2.21 4
Lampas 1.66 0.27 0.41 0.64 0.36 4289.66 33.80 30.42 0.32 3.28 3
Lauricocha 1.56 0.38 0.64 0.76 0.40 4434.36 35.29 31.77 0.32 2.20 3
Linda 1.49 0.51 0.64 0.88 0.44 4234.88 31.67 28.50 0.29 3.50 3
Manish 1.86 0.42 0.81 0.79 0.28 4048.45 36.84 33.16 0.33 2.33 3
Maranon 1.53 0.43 0.94 0.81 0.42 3443.95 46.59 41.93 0.31 2.58 4
Maria Huaita 1.44 0.32 0.38 0.69 0.48 3766.83 38.03 34.23 0.25 2.68 3
Matacac 1.71 0.79 1.30 1.09 0.34 4017.42 39.55 35.59 0.25 2.68 3
Mosna 1.42 0.50 1.05 0.87 0.49 4410.72 46.90 42.21 0.28 2.27 4
Nupe 1.37 0.81 1.20 1.11 0.53 4571.54 43.49 39.15 0.30 2.17 3
Nupe Nupe 1.63 0.57 1.19 0.93 0.37 4062.94 30.32 27.29 0.07 2.33 3
Pomabamba 1.45 0.47 0.71 0.84 0.47 3880.32 41.04 36.94 0.29 2.02 4
Puchca 1.39 0.75 0.95 1.06 0.51 3624.60 54.78 49.30 0.29 2.23 3
Pucroj 1.32 0.92 1.11 1.18 0.57 3957.22 41.68 37.51 0.31 2.33 3
Purhuay 1.48 0.49 0.90 0.86 0.45 4317.47 50.65 45.59 0.32 2.28 3
Rancasa 2.08 0.20 0.40 0.55 0.23 3705.04 49.22 44.30 0.32 2.16 4
Runichinchay 1.28 0.44 0.69 0.81 0.60 4340.35 58.85 52.97 0.29 3.50 3
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Tabla 4.5. Parametros geomorfomeétricos de las subcuencas de la cuenca de Marafién

Parametros de forma

Parametros de relieve

Paradmetros de drenaje

Subcuenca Coeficieqte de Factor de Coeficiente Relacic’)n_ Ide Relaciép de Al_titud Pendiente Zi??:;eunct: Dg':gf;g _de R_elacic’)n_(,je Ord_en de
compacidad forma (Ff) de forma | Elongacion | circularidad | media - Am | de la cuenca principal - Dd bifurcaciéon | corrientes
(Co) (CP) (Re) (Re) (m.s.n.m.) - S (%) Sc (%) (km?/km) (Rb) (Oc)

Rupac 1.57 0.55 0.84 0.91 0.40 3607.24 42.66 38.39 0.06 3.50 3
San Juan 1.35 0.39 0.67 0.77 0.54 4113.22 40.95 36.85 0.30 3.03 3
San Martin 171 0.95 1.80 1.20 0.34 3898.94 35.92 32.33 0.28 2.13 3
San Nicolas 1.54 0.36 0.66 0.74 0.41 3684.88 44.61 40.15 0.28 2.10 3
Sarin 1.44 0.33 0.49 0.71 0.47 3798.05 38.57 34.71 0.28 2.67 2
Shiusha 1.41 0.38 0.53 0.76 0.50 4061.20 35.21 31.68 0.27 2.25 3
Shuyanga 1.60 1.43 2.73 1.47 0.39 2825.80 44.14 39.72 0.35 3.00 2
Taparaco 2.01 0.19 0.29 0.53 0.24 4231.11 35.65 32.08 0.29 3.33 2
Tranca 1.78 0.59 1.32 0.95 0.31 3685.90 46.72 42.04 0.30 2.26 4
Uctubamba 1.52 0.58 0.69 0.93 0.43 3374.30 55.48 49.93 0.26 2.01 4
Yanamayo 1.64 0.86 1.50 114 0.37 3402.01 45.46 40.91 0.31 2.52 3
Yurma 1.60 0.36 0.75 0.74 0.38 4084.03 52.92 47.63 0.28 2.08 3
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4.3. Determinacion de la relacién de parametros geomorfometricos
Para el andlisis de la relacion de los pardmetros geomorfométricos se
utilizé el software SPSS, con lo cual se realiz6 un anélisis siguiendo
procedimientos estandares verificando que existe diversas relaciones entre

los parametros.

4.3.1 Correlacion de Pearson
Se encontraron correlaciones altas, confirmando lo encontrado en la
descripcion de los parametros geomorfométricas. Por ejemplo, se
encuentran muy relacionados el coeficiente de compacidad con
relacion de circularidad, factor de forma con coeficiente de forma 'y
relacion de elongacion, relacién de circularidad con coeficiente de
compacidad, relacion de circularidad con pendiente de la cuenca y
pendiente del cauce principal, altitud media con pendiente de la
cuenca y pendiente del cauce principal, pendiente de la cuenca con
la pendiente del cauce principal, con una correlaciéon menor a 0.01
de significancia, el coeficiente de compacidad con la pendiente de la
cuenca y pendiente del cauce principal con una correlacion menor a
0.05 de significancia, mientras el resto de los parametros no

muestran una relacion clara.
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Tabla 4.6. Correlacién de Pearson

Correlacion de 1.000 | 0075 | 0176 | -0.061 | -978™ | 0.030 | -,298" | -293° | 0.095 | 0.199 | -0.043

Cc | Pearson
Sig. (unilateral) 0.298 | 0106 | 0333 | 0000 | 0416 | 0.018 | 0018 | 0252 | 0.079 | 0.382
Correlacion de 0.075 | 1.000 | ,950" | 971" | -0.025 | -0.132 | -0.030 | -0.030 | 0.108 | 0.149 | -0.014

Ff | Pearson
Sig. (unilateral) 0.298 0.000 | 0000 | 0430 | 0175 | 0417 | 0.417 | 0.223 | 0.146 | 0.460
Correlacion de 0.176 | 950" | 1.000 | 932" | -0.149 | -0.170 | -0.074 | -0.074 | 0.100 | 0.110 | -0.020

Cf |Pearson
Sig. (unilateral) 0.106 | 0.000 0.000 | 0145 | 0114 | 0.300 | 0300 | 0.240 | 0.218 | 0.443
Correlacion de 0061 | 971 | 932 | 1000 | 0.097 | -0.178 | 0015 | 0.015 | 0.068 | 0.050 | 0.020

Re |Pearson
Sig. (unilateral) 0.333 | 0.000 | 0.000 0.247 | 0103 | 0459 | 0459 | 0.315 | 0.361 | 0.443
Correlacion de -978™ | -0.025 | -0.149 | 0.097 | 1.000 | -0.005 | ,334™ | 334" | -0.066 | -0.184 | 0.054

Rc | Pearson
Sig. (unilateral) 0.000 | 0430 | 0145 | 0.247 0486 | 0.008 | 0008 | 0321 | 0.096 | 0.351
Correlacion de 0.030 | -0.132 | -0.170 | -0.178 | -0.005 | 1.000 | -424™ | -424™ | 0.008 | 0.088 | -0.093

Am | Pearson
Sig. (unilateral) 0416 | 0175 | 0114 | 0.03 | 0.486 0.001 | 0001 | 0478 | 0.267 | 0.255
o g:;se(';c'o” de -293" | -0.030 | -0.074 | 0015 | ,334™ | -424™ | 1.000 | 1,000” | 0.107 | -0.140 | 0.201
Sig. (unilateral) 0.018 | 0417 | 0300 | 0459 | 0.008 | 0.001 0.000 | 0.224 | 0.162 | 0.077
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Tabla 4.6. Correlacién de Pearson

Correlacion de 293" | -0.030 | -0.074 | 0015 | 334 | -424™ | 1,000™ | 1.000 | 0.107 | -0.140 | 0.201
Sc Pearson

Sig. (unilateral) 0018 | 0417 | 0300 | 0459 | 0008 | 0001 | 0.000 0224 | 0161 | 0.077

Correlacion de 0095 | 0.108 | 0.100 | 0.068 | -0.066 | 0.008 | 0.107 | 0107 | 1.000 | -0.034 | -0.004
Dd | Pearson

Sig. (unilateral) 0252 | 0223 | 0240 | 0315 | 0321 | 0478 | 0224 | 0224 0405 | 0.488

Correlacion de 0199 | 0149 | 0.110 | 0050 | -0.184 | 0.088 | -0.140 | -0.140 | -0.034 | 1.000 | -0.192
Rb Pearson

Sig. (unilateral) 0079 | 0146 | 0218 | 0361 | 0.096 | 0267 | 0162 | 0.161 | 0.405 0.086

Correlacion de -0.043 | -0.014 | 0020 | 0.020 | 0054 | -0.093 | 0201 | 0201 | -0.004 | -0.192 | 1.000
Oc Pearson

Sig. (unilateral) 0382 | 0460 | 0443 | 0.443 | 0351 | 0255 | 0077 | 0.077 | 0.488 | 0.086

**_La correlacion es significativa en el nivel 0,01 (unilateral).
*. La correlacion es significativa en el nivel 0,05 (unilateral).
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4.3.2 Analisis de componente principal (ACP)

Para poder determinar la correlacion de los diferentes parametros de

ha realizado el analisis del componente principal, para los cual se

aplico la prueba de Kaiser-Meyer-Olkin y la prueba de esfericidad

de Bartlett tal como se muestra en la tabla 4.7.

Tabla 4.7. Prueba de KMO vy Bartlett

adecuaciéon de muestreo

Medida Kaiser-Meyer-Olkin de

Prueba de esfericidad
de Bartlett

0.605
Aprox. Chi- 1174.547
cuadrado
gl 55
Sig. 0.000

En la Tabla 4.8 se muestran la desviacion estdndar de cada

componente (valores propios) y su varianza explicada encontrada en

el ACP. De ésta se puede inferir que el porcentaje de varianza

explicado 6ptimo donde los valores propios para cada componente

son mayores a 1 (Pefia, 2002), se encuentran hasta el componente 5,

explicando aproximadamente el 86% de la varianza en las relaciones

presentadas para los valores de los parametros geomorfométricos.

Tabla 4.8. Valores propios y su varianza explicada (ACP)

Componente | Desv. St. . Yoo . .% varianza
varianza explicada | Explicada acumulado
1 3.019 27.449 27.449
2 2.833 25.751 53.199
3 1.618 14.714 67.913
4 1.069 9.721 77.634
5 1.001 9.097 86.731
6 0.808 7.346 94.077
7 0.571 5.191 99.268
8 0.048 0.438 99.706
9 0.021 0.191 99.896
10 0.011 0.104 100.000
11 0.00 0.00 100.000
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En la Figura 4.1 se muestran los pardmetros que se encuentran mas
préximos a los componentes con las que se correlacionan, se puede
observar que la altitud media es el que se acerca mas a los tres
componentes, seguido de Coeficiente de la pendiente de la cuenca,

pendiente del cauce principal y la relacién de circularidad.

| s
I s
Sc

me O D Oc,: Ff
0,07 2 Rb

oo
Re Cf

Componente 2

1,0

_'flan

_G'IS a0 o5

Componen:\e 1 comp
Figura 4.1. Componentes en el espacio rotado.
El componente uno separa grupos de parametros relacionados a la a
la forma de las cuencas hidrogréficas, tales como factor de forma,
relacion de elongacion coeficiente de forma, el componente dos
separa los parametros de relieve como es la altitud media, pendiente
de la cuenca y pendiente del cauce principal y los parametros de
forma que interviene en los parametros de relieve, el componente
tres separa los parametros de forma y relieve los cuales intervienen

en los parametros de drenaje.
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Los componentes restantes reflejan caracteristicas particulares de los
parametros a las que se asocia un poder de explicacion especifico
menor al 5%.

Las relaciones mas fuertes dadas por el ACP se presentan en relacion
al valor de la pendiente de la cuenca con la pendiente del cauce
principal, seguido de los pardmetros de formay relieve, la separacion
que muestra el ACP entre caracteristicas ligados a la formas y relieve
de las cuencas, los cuales son utilizados para el calculo de los

parametros de drenaje.

4.3.3 Modelos de prediccion de los parametros de forma
a. Modelo de prediccion entre los parametros Cc y Ff
C. = 1.99 — 1.40F; + 1.08F;* — 0.20F;° (4.1)
R?=10.590
1.28<=Cc<=2.08 y 0.19<=Ff<=3.08
Donde:
Cc: Coeficiente de compacidad
Ff: Factor de forma
b. Modelo de prediccion entre los pardametros Cc y Re
C. = 3.79 — 3.59R, + 3.91R,? — 0.83R,° (4.2)
R?=10.690
1.28<=Cc<=2.08 y 0.53<=Re<=2.15
Donde:
Cc: Coeficiente de compacidad

Re: Relacion de elongacion
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c. Modelo de prediccién entre los parametros Cc y Rc

Ce = 0.997xe~0-50Rc (4.3)

R?=0.998

1.28<=Cc<=2.08 y 0.23<=Rc<=0.60

Donde:
Cc: Coeficiente de compacidad
Rc: Relacion de circularidad
d. Modelo de prediccion entre los parametros Ffy Cf
Ff = —0.056 + 0.853C; — 0.236C;* + 0.046C;° (4.4)
R?=0.925
0.19<=Ff<=3.08 y 0.29<=Cf<=4.45
Donde:
Ff: Factor de forma
Cf: Coeficiente de forma
e. Modelo de prediccion entre los parametros Ffy Re
Ff= —0.011 — 0.024R, + 0.675R,* (4.5)
R?=1.00
0.19<=Ff<=3.08 y 0.53<=Re<=2.15
Donde:
Ff: Factor de forma
Re: Relacion de elongacion
f. Modelo de prediccién entre los parametros Ffy Rc

Fe = 2.827 — 12.82R, — 12.826R.* — 7.65R.> (4.6)

R? =0.643
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0.19<=F<=3.08 y 0.23<=Rc<=0.60
Donde:

Ff: Factor de forma

Rc: Relacion de circularidad

g. Modelo de prediccion entre los parametros Cfy Re

Cf = —0.061 + 0.326R, + 0.828R,> (4.7)
R?=0.906
0.29<=Cf<=0.60 y 0.53<=Re<=215
Donde:
Cf: Coeficiente de forma
Re: Relacion de elongacion
4.3.4 Modelos de prediccion de los parametros de relieve
a. Modelo de prediccion entre los parametros Amy S
A, = 3033.502 + 61.423S — 0.939S2 (4.8)
R? = 0.604
2804.72 <= Am <=4571.54 y 30.32 <=S<=63.62
Donde:
Am: Altitud media de la cuenca
S: Pendiente de la cuenca
b. Modelo de prediccion entre los pardmetros Sy Sc
S = 0.004 + 1.111xS, (4.9)
R?=1.00

30.32<=S<=63.62 y 27.29<=Sc<=57.26
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Donde:
S: Pendiente de la cuenca

Sc: Pendiente del cauce principal

4.3.5 Modelos de prediccion de los parametros de drenaje
a. Modelo de prediccion entre los parametros Rby Oc
R, = 7.684 — 3.0680, + 0.4870,* (4.10)
R%=0.740
201<=Rb<=420 y 2<=0c<=4
Donde:
Rb: Relacion de bifurcacion

Oc: Orden de las corrientes

4.3.6 Modelos de prediccion de los parametros de formay drenaje
a. Modelo de prediccion entre los parametros Cfy Rb
Ce = 3.98 — 2.24R,, + 0.394R,,* (4.11)
R?=0.690
0.29<=Cf<=445 y 201<=Rb<=4.20
Donde:
Cf: Coeficiente de forma

Rb: Relacién de bifurcacion

4.3.7 Modelos de prediccion de los parametros de formay relieve
a. Modelo de prediccion entre los parametros Rcy S
R. = —0.205xlog 0.163xS (4.12)
R? = 0.660

0.23<=Rc<=0.60 y 30.32<=S<=63.62
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Donde:
Rc: Relacion de circularidad

S: Pendiente de la cuenca

4.3.5 Calculo de los parametros de la ley de Hack
La ley de Hack encontrd una relacion empirica de la longitud del
canal principal de una cuenca con el area de la misma, tal como se
muestra en la ecuacion (14), en la cual los parametros C y h son
propios para cada cuenca.
Se ha realizado el célculo de los pardmetros de la ley de Hack para
la cuenca de Marafion, utilizando los datos de las subcuencas, tal
cOmo se muestra en la siguiente ecuacion.
L =1.361xA%508 (4.13)
Donde:
L: Longitud de cauce

A: Area de la cuenca
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5.1.

5.2.

V. DISCUSION
Vectorizacion y codificacion
Siguiendo la metodologia Pfasftetter se realizd la vectorizaciéon y
codificacion de las subcuencas de la cuenca de Marafion, en la que se
encontrd 52 subcuencas de nivel 7 (tabla 4.1), la autoridad nacional del
agua (ANA) solo tiene codificado hasta el nivel 6 de todas las subcuencas
del Per(, con lo que se esta realizando el aporte de los datos hasta este
nivel.
Parametros geomorfométricos
5.2.1 Paréametros de forma
Se ha realizado el analisis de los parametros de forma (tabla 4.2), en
la que se han encontrado un &rea minima de 66.23 km? para la
subcuenca Shuyanga y un area maxima de 1364.32 km? para la
subcuenca Uctubamba.
Para la clasificacién de las cuencas segun el tamafio, se tiene
subcuencas de tipo pequefio, intermedio-pequefio e intermedio-
grande de la cuenca de Marafion.
En la tabla 4.1 se ha determinado que el coeficiente de compacidad
varia de 1.28 a 2.08 para las subcuencas Runichinchay y Rancasa
respectivamente, para estos valores se puede definir que se tiene
subcuencas de forma alargada y redonda, el cual tiene una influencia
directa en el tiempo de concentracion.
El factor de forma varia de 0.19 a 3.08 para las subcuencas Taparaco

y Batan respectivamente, el coeficiente de forma varia de 0.29 a 4.45
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para las subcuencas Taparaco y Batan respectivamente, con esto se
puede definir que las subcuencas son ligeramente a moderadamente
achatadas, el cual tendré una incidencia directa en las crecientes de
cada subcuenca.

La relacion de elongacion varia de 0.53 a 2.15 para las subcuencas
de Taparaco y Batan respectivamente, la relacion de circularidad
varia de 0.23 a 0.60 para las subcuencas Rancasa y Runichinchay
respectivamente el cual defina la forma de la cuenca si es alargada o

redonda.

5.2.2 Parametros de relieve
En la tabla 4.3, se ha determina que la altitud varia de 2804.72
m.s.n.m. para la subcuenca Chocta a 4571.54 m.s.n.m. para la
subcuenca Nupe, la pendiente de las subcuencas varia de 30.32%
para Nupe Nupe hasta 63.62% para Chocta, con lo que se puede

observar que las subcuencas tienen una pendiente suave a moderado.

5.2.3 Parametros de relieve
En la tabla 4.4, se ha determinado que la densidad de drenaje varia
de 0.06 km?km a 0.35 km?km para las subcuencas Rupac y
Shuyunga respectivamente, con lo se puede definir que las
subcuencas tienen de baja a regular densidad de drenaje, la relacion
de bifurcacion varia de 2.01 a 4.20 para las subcuencas Uctubamba
y Batan respectivamente, con lo que se puede observar que tiene

variaciones considerables en sus caracteristicas geoecologicas, el
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orden de las corrientes se tiene de orden 2,3 y 4, para las distintas
subcuencas de la cuenca de Marafion.
5.3. Relacion de pardmetros geomorfométricos.

Para poder determinar la correlacion de los parametros geomorfométricos
se aplico el coeficiente de correlacion de Pearson en la cual se define una
significanciade 0.01 y 0.05, en la tabla 4.6. se obtuvo una correlacion entre
el coeficiente de compacidad y relacion de circularidad con coeficiente de
Pearson de -0.978 y un nivel de significancia de 0.000, factor de forma 'y
coeficiente de forma con coeficiente de Pearson de 0.950 y un nivel de
significancia de 0.000, factor de forma y relacion de elongacion con
coeficiente de Pearson de 0.971 y un nivel de significancia de 0.000,
coeficiente de forma y relacion de elongacion con coeficiente de Pearson
de 0.932 y un nivel de significancia de 0.000, relacion de circularidad y
pendiente de la cuenca, pendiente del cauce principal con coeficiente de
Pearson de 0.334 y un nivel de significancia de 0.008, altitud media y
pendiente de la cuenca, pendiente del cauce principal con coeficiente de
Pearson de -0.424 y un nivel de significancia de 0.001, altitud, pendiente
de la cuenca y la pendiente del cauce principal con coeficiente de Pearson
de 1.000 y un nivel de significancia de 0.000 y coeficiente de compacidad
con pendiente de la cuenca, pendiente del cauce principal con coeficiente
de Pearson de -0.293 y un nivel de significancia de 0.018.
Los resultados obtenidos tienen un nivel se significancia menor a 0.01 en
su mayoria y una parte tiene un nivel de significancia menor a 0.05, el

coeficiente de Pearson varia de -0.978 a 1.00, con esto se puede describir
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que existe una correlacion positiva perfecta, correlacion positiva y
correlacion negativa, ya que los valores negativos del coeficiente de

Pearson representan una correlacion negativo, los valores positivos
representa una correlacién positivo y el valor 1 representa una correlacion
perfecta.

En el analisis de componente principal (ACP), se ha determinado la
conformacién de los componentes con el criterio de la desviacién estandar
mayor a 1y el porcentaje acumulado de variancia explicada que debe ser
mayor a 80%, con lo que se obtuvo 6 componentes, los cuales explican la
correlacion de las de los parametros de forma, parametros de relieve y la
correlacion de forma, relieve y drenaje.

Una vez determinado la correlacion de los distintos parametros se ha
propuesto modelos de prediccion de regresion entre el coeficiente de
compacidad (Cc) y factor de forma (Ff) en un 59% de nivel significancia,
coeficiente de compacidad (Cc) y relacion de elongacion (Re) en un 69%
de nivel significancia, coeficiente de compacidad (Cc) y relacion de
circularidad (Rc) en un 99.8% de nivel significancia, factor de forma (Ff)
y coeficiente de forma (Cf) en un 92.5% de nivel significancia, factor de
forma (Ff) y relacion de elongacion (Re) en un 100% de nivel
significancia, factor de forma (Ff) y relacion de circularidad (Rc) en un
64.3% de nivel significancia, coeficiente de forma (Cf) y relacion de
elogacion (Re) en un 90.6% de nivel significancia, relacion de bifurcacion
(Rb) y orden de las corrientes (Oc) en 74% de nivel significancia,

coeficiente de forma (Cf) y relacién de bifurcacién (Rb) en un 69% de
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5.4.

nivel significancia, relacion de circularidad (Rc) y pendiente de la cuenca
(S) en 66% de nivel significancia, altitud media (Am) y pendiente de la
cuenca (S) en 60.4% de nivel significancia, pendiente de la cuenca (S) vy
pendiente de la cauce principal (Sc) en 100% de nivel significancia.

Estos modelos predictivos permitiran determinar algin parametro a partir
de los datos obtenidos para una cuenca determinada.

Calculo de los parametros de la ley de Hack

Hack (1957), demostro la aplicabilidad de una funcion potencial que
relaciona la longitud del canal principal de una cuenca con su area,
encontrando la ecuacion L=CA", la variable h varia de 0.5 a 0.6, generando
un comportamiento anomalo del exponente esto debido a la caracteristica
de elongacion.

El caracter fractal del canal principal y el aumento de la sinuosidad hacia
aguas abajo y el valor esperado del parametro C es de 1.40. Mantilla, Mesa
y Poveda (2000), en su investigacion encontraron los valores de 1.4944 y
1.7389 para el parametro C, valores de 0.5533 y 0.5253 para el parametro
h en las cuencas de Magdalena y Atrato respectivamente que estan
ubicados en Colombia. Mantilla, Mesa y Poveda (2000) en su
investigacion analizando 1000 cuencas de Colombia encontraron el valor
de 1.43 para el parametro C y 0.56 para el parametro h. En la investigacion
se ha analizado 52 subcuencas de la cuenca de Marafion, obteniendo, con
lo cual se ha obtenido un valor de 1.361 para el parametro C y 0.508 para

el parametro h de la ley de Hack, las cantidades obtenidas en la
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investigacion tiene valores esperados para la férmula de Hack en las
cuentas hidrogréficas.

En la investigacion se analizd 52 subcuencas de la cuenca de Marafidn,
con la cual se obtuvo un valor de 1.361 para el parametro C y 0.508 para
el pardmetro h de la ley de Hack, las cantidades obtenidas en la
investigacion tiene valores esperados para la formula de Hack en las

cuencas hidrogréfica.
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VI. CONCLUSIONES

Del trabajo de investigacion realizado se concluye:

1. Se determinaron las relaciones entre los pardmetros geomorfométricos de
las subcuencas de la cuenca Marafion mediante GIS.

2. Lacuenca de Marafion tiene 52 subcuencas de nivel 7.

3. Los pardmetros geomorfométricos de las subcuencas de la cuenca de
Marafién son los que indican: las areas de las subcuencas que varian de
66.23 km? a 1364.34 km?, los coeficientes de compacidad varian de 1.28
a 2.08, los factores de forma varian de 0.19 a 3.08, los coeficientes varian
de forma de 0.29 a 4.45, las relaciones de elongacion varian de 0.53 a
2.15, las relaciones de circularidad varian de 0.23 a 0.60, las altitudes
medias varian de 2804.72 m.s.n.m. a 4571.54 m.s.n.m., las pendientes de
las subcuencas varian de 30.32% a 63.62%, las pendientes de los cauces
principales varian de 27.29% a 57.26%, las densidades de drenaje varian
de 0.06 km?/km a 0.35 km?/km, y las relaciones de bifurcacion varian de
2.01a4.20.

4. Entre los modelos de prediccion méas importantes que se encontraron son:
a) Modelo de prediccion entre los parametros Sy Sc

S = 0.004 + 1.111xS,
R%=1.00
Donde:
S: Pendiente de la cuenca
Sc: Pendiente del cauce principal

b) Modelo de prediccion entre los parametros Rb y Oc
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Rp = 7.684 — 3.0680, + 0.4870,°
R?=0.740
Donde:
Rb: Relacion de bifurcacion
Oc: Orden de las corrientes
¢) Modelo de Hack:
L = 1.361xA%508
Donde:
L: Longitud de cauce

A: Area de la cuenca
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VIl. RECOMENDACIONES
Del trabajo de investigacion realizado se recomienda:
1. Utilizar la metodologia empleada en la presente investigacion para
determinar los parametros geomorfométricos en otras cuencas.
2. Aplicar los diferentes tipos de modelos encontrados y determinar los
pardmetros correspondientes en otras cuencas nacionales 0

internacionales.
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Anexo 01: Frecuencia de altitudes y las curvas hipsométricas de las subcuencas
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90




5159
5021
4861
4703
4547
4392
4241
4082
3929
3764
3590
3453

Altitud Promedio (msnm)

”'[HI[F

0.000 10.000 20.000 30.000 40.000 50.000 60.000 70.000 80.000 90.000 100.000

Intervalos

5 INTERVALOS

Figura 8.33. Frecuencia de altitudes de la subcuenca Huacoto

6000

5000

4000

3000

2000

Cota Promedio (m.s.n.m.)

1000

Figura 8.34. Curva hipsométrica de la subcuenca Huacoto

[

o

50

100

150 200 250 300
Area Acumulada (Km2)

350

400

450




4574
4370
4193

I ———————

T —————————
e —————————
———

——

I

3833
3642
3443
3250
3055
2867
2672
2428

0.000 10.000 20.000 30.000 40.000 50.000 60.000 70.000 80.000 90.000 100.000
Intervalos

Altitud Promedio (msnm)

I

u INTERVALOS

Figura 8.35. Frecuencia de altitudes de la subcuenca Huacrachuco

5000

4500 \.\
~—|

— 4000 |

3500 -

3000 \

1500

Cota Promedio (m.s.n.m
N N
o (O]
o o
o o

[
o
o
o

500

0 50 100 150 200 250 300 350 400 450
Area Acumulada (Km2)

Figura 8.36. Curva hipsométrica de la subcuenca Huacracuco
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Figura 8.38. Curva hipsométrica de la subcuenca Huancas
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Anexo 03: Matriz de consistencia ldgica

Problema

Objetivos

Hipdtesis

Variables

Dimensién

Indicadores

Problema general
¢Existiran relaciones
entre las  variables
geomorfométricas de las
subcuencas de la cuenca
Marafién?

Objetivo general
Determinar las relaciones entre los

parametros geomorfométricos de

las subcuencas de la cuenca
Marafién mediante GIS
Objetivos especificos
1.- Delimitar las subcuencas
empleando el  sistema  de
informacién geografica.
2.- Calcular los parametros

geomorfométricos de las
subcuencas de la cuenca de
Marafiéon mediante GIS.

3.- Hallar las relaciones entre los
parametros geomorfométricos de
las subcuencas de la cuenca
Marafion.

Hipotesis General

Existen relaciones
significativas  entre  los
pardmetros

geomorfométricos de las
subcuencas de la Cuenca
Marafion.

Se  consideran los
parametros de forma,
tales como coeficiente de
compacidad, factor de
forma, coeficiente de
forma, relacion de
elongacion, relacion de
circularidad, pardmetros
de relieve tales como
altitud media, pendiente
de la cuenca, pendiente
del cauce principal, vy
pardmetros de drenaje
densidad de drenaje,
relacion de bifurcacion,
orden de las corrientes

X1: Parametros de
forma.

X2: Parametros de
relieve.

X3: Parametros de
drenaje.

- Relacion de perimetro y el

area.
- Relacion de ancho y largo.

- Relacion de ancho medio y

longitud.

- Relacién de diametro y y

longitud media.

- Relacién de area del circulo y

longitud.
-m.s.n.m.

- porcentaje
- km/km2

- Cantidad.
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